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— Einfdhrung —

Die Kamera bewegen

Um die Kamera in der X- und Y-Richtung zu
bewegen, den mittleren Mausknopf anklicken
und vorsichtig mit der Maus fahren. Einfach auf
den linken Mausknopf klicken, um die
Einstellung zu fixieren. Um die Kamera in der Z-
Richtung zu bewegen, den mittleren Mausknopf
gedriickt halten und die Maus bewegen. Wenn
der Knopf los gelassen wird, befindet sich die
Kamera im X/Y Bewegungsmodus und Sie
missen den linken Mausknopf kurz anklicken
um die Einstellung zu fixieren.

An-und Abwéahlen

Wenn sich die Maus in der Nahe eines
wahlbaren Teils des Objektes befindet, wird
dieser Teil grin. Wird auf den linken Knopf der
Maus geklickt, wird dieser Teil rot, was bedeutet,
das er gewahlt ist. Befindet sich die Maus in der
Néahe eines gewahlten Teils, wird dieser orange.
Klickt man auf einen gewahlten Teil, wird er
abgewahlt. Um alles Gewahlte auf einmal
abzuwahlen, die Leertaste auf der Tastatur
betatigen.

Voraussetzungen

Diese Anleitung geht davon aus, dass Sie Uber
Kenntnisse in Wings3D veffligen und sich mit
Ihrem Grafikprogramm gut auskennen. Ich
benutze Photoshop Elements 2.0 fur diese
Anleitung aber alles in einer ahnlichen Klasse
wie Photoshop und PaintShopPro geht. Falls
Sie kein Grafikprogramm haben, holen Sie sich
das Freeware Programm GIMP von

http://www.aimp.ora/
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Vorbereitungen

Bevor Sie mit irgend etwas beginnen, stellen Sie
sicher, dass Sie «Geometry Graph» und
«Outliner» geotffnet haben.

Window > Geometry Graph
Window > Outliner

Offnen Sie das Modell, von welchem Sie eine
Abwicklung erstellen mdchten. Ich habe einen
einfachen Pilz mit der Extrude-Funktion erstellt,
den ich fur diese Anleitung benutze.
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Um AutoUV (automatische Abwicklung) zu aktivieren, wechseln Sie in den Objekt Modus und
wahlen das gewunschte Objekt. Durch einen Rechtsklick 6ffnet sich das Kontext-Menu und
zuunterst die Option «UV Mapper». Klicken Sie darauf. Ein Fenster springt auf der rechten Seite
des Bildschirms auf. Driicken Sie die Taste «o» um in die orthogonale (rechteckige) Ansicht zu
gelangen.

UV Mapping = Abwickeln:

Zylinder: Dies sind die schwierigsten Objekte um abzuwickeln. Ich benutze den Stiel des Pilzes um
meine Technik zu zeigen. Wahlen Sie als erstes den Zylinder im Seitenmodus, den Sie abgewickelt
haben mochten. Mit einem Rechtsklick kdnnen Sie eine Farbe auswahlen (es spielt Uberhaupt keine
Rolle, welche; wahlen Sie einfach eine — es wird spater keinen Unterschied machen). Die Farben
werden zum Auseinanderhalten der verschiedenen Teile in der Abwicklung benutzt. Andere Farbe,
anderes Teil. Wenn Sie Ihren Zylinder eingefarbt haben, wahlen Sie eine Kante, welche entlang
einer Halfte des Zylinders verlauft. Nun ein Rechtsklick und «Mark Edges for Cut» (Schnittkante
markieren) wahlen. Die gewahlte Kante wird griin. Das war's dann fur den Zylinder.
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Samiritra
Anderes: Alle anderen Formen sind ziemlich offensichtlich, ausgenommen der Tatsache, dass
keine geschlossene Form abgewickelt werden kann (mit anderen Worten: Es wird mindestens eine
Schnittkante oder eine Seite mit einer anderen Farbe bendtigt).
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Abwickeln: Wenn Sie alle Seiten eingefarbt und richtig geschnitten haben, wéahlen Sie alles ab. Mit
einem Rechtsklick gehen Sie zu Continue > Unfolding (weiter > abwickeln). Nach der Abwicklung
sehen Sie die flachen Seiten, welche Sie definiert hatten. Wenn Sie wollen, kbnnen Sie diese nun
skalieren und verschieben, aber verformen Sie diese nicht. Ist dies alles erledigt, rechtsklicken und
«Create Texture» (Textur erzeugen) auswahlen. Die Gro3e kann beliebig sein. SchlieRen Sie das
nicht! Verkleinern Sie das Fenster einfach und schieben es etwas zur Seite. Wenden Sie Ihre
Aufmerksamkeit nun dem Werkzeugfenster «Outliner» zu. Hier sollten Sie ein Quadrat vorfinden,
welches als «diffuse» bezeichnet ist. Rechtsklicken Sie auf den diffuse-Text und wéahlen Sie «make
external» (Externes machen). Speichern Sie das Bild der Abwicklung unter einen beliebigen
Namen.

Arbeit mit dem Grafikprogramm:

Benutzen Sie fur das Folgende ein geeignetes Grafikprogramm. Photoshop geht am Besten aber
alles, was Pinsel (Brush) und Ebenen (layers) klont, ist geeignet. Finden Sie ein Bild im Internet
(oder machen Sie sich eines, wenn Sie eine Digitalkamera besitzen) der Textur(en), welche Sie fur
die Abwicklung benutzen mdchten. Importieren Sie diese Bilder sowie die Abwicklung in das
Grafikprogramm. Legen Sie diese alle in das selbe Dokument als verschiedene Ebenen. Dublizieren
Sie den Hintergrund und l6schen Sie anschliel3end das Original. Dies stellt sicher, dass der
Hintergrund nicht gesperrt (locked) ist. Wenn Sie eine Textur benttzen wollen, dublizieren Sie diese
ebenfalls und verstecken (hide) Sie das Original. Das stellt sicher, dass Sie es immer und immer
wieder benutzen kdnnen, ohne das Original zu deformieren. Ist die Textur zu klein, benltzen Sie
den Klonpinsel (clone brush) um es ohne zu deformieren zu expandieren. Ich kann die Prozedur
nicht wirklich dokumentieren, weil es sich jedes Mal anders verhalt.

Abschliel3en:

Speichern Sie die fertige Abwicklung tber die unfertige, dann gehen Sie zurtick zu Wings,
rechtsklicken auf «diffuse» und wahlen «refresh» (erneuern). Dies zeigt lhnen nun das Resultat,
wenn auch nicht alle Einzelheiten, der Abwicklung. Sie kdnnen das Objekt nun in das 3DS oder OBJ
Format exportieren. Diese beiden Formaten sind die einzigen mit welchen ich erfolgreich Modell mit
den Abwicklungen habe exportieren konnen.

Lito Nicolai
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— Schritt-fur-Schritt Beispiel —

Edge operations

Move

WINGS Kurzanleitung

Erstellen Sie einen Zylinder, indem
Sie im Fenster rechtsklicken.

Wahlen Sie den Kantenmodus

Connect
Bewvel

C Radlial ¥
Radial £

durch Auswahlen der Pyramide mit
den roten Kanten. Wahlen Sie alle
16 Kanten, welche die obere
Flache beschreiben.

Rechtsklicken Sie und wahlen vom

liz=zolve
Collzpse

Hardress ]

Loop Cut

Yertew Color

Intersect ]

Face operations

Mo e
Rotate
Scale

Extrude
Extrude Region
Extract Region

Flatten

] Free
] bt

¥
|z

TF‘IT"I:I‘I'
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Kontextmeni «Scale» > «Radial
Y», dann bewegen Sie die Maus,
bis der Durchmesser in der oberen
linken Ecke des Fensters mit
20.00% angezegt wird:
Linksklicken.

Wir haben einen gekopften Konus.

Wahlen Sie die Kanten ab. Im
Seitenmodus wahlen Sie vier um 90°
verschobene Seiten. Rechtsklicken,
«Extrude» > «Normal» wahlen und die
maus bewegen, bis in der oberen linken
Exke des Fensters etwa 1.0 erreicht ist.

Auf diese Weise haben wir vier Flugel
am gekopften Konus befestigt. Kein sehr
kompliziertes Modell, aber es reicht fur
diese Schritt-fiir-Schritt Ubung.

www .horo.ch
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Ubject operations Los geht's mit dem Hauptthema:

Move 3 Abwickeln.

Fotate 3

Scale b Waéhlen Sie den Objekt Modus und

Flip , weil noch einige Seiten gewahlt sind,
wird gleich das ganze Modell

Inwert selektiert.

Tighten ) ]

Srnoath 5 Rechtsklicken Sie, um das

Cornbing Kontextmeni zu 6ffnen. Ganz zu

Sl unterst klicken Sie auf «UV Mapping»

Weld O (Abwicklung).

CleanLp 0

Auto-Smooth 0

Duplicate ]

Delete Bk=p

Rename...

Yertes Color Mode
Object Ta Area Light
Materizlz to Colors
Yerte: Color

N Mapping
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Das AutoUV (automatisch Ab-
Autol: cylinderl Xl wickeln) Fenster 6ffnet sich.
Verschieben und skalieren
Sie es nach Wunsch. Im
v - Seiten-

20 faces selected

modus wahlen Sie nun die
\ zwolf verbleibenden Seiten
des Zylinders, dann
\ rechtsklicken Sie und und

geben ihnen eine Farbe z. B.
\ AuvChartl.

Wahlen Sie alles ab, indem
Sie auf die Leerschlagtaste
hauen und Sie sehen die

Cantinue | vergebene Farbe. Wahlen Sie

Segment by b nun o!ie obere upd untere
Scheibe des Zylinders und

AuvChartl O geben Sie diesen eine andere

= Farbe (AuvChart2) wie vorhin.
Alles abwahlen.

Ay Chartd O

AuCharts 1 Wahlen Sie schlieRlich alle

AL S : funf Seiten der vier Flugel und

Auy ChartT vergeben eine weitere Farbe

awcharts B4 (i links, AuvChart3).

ALy Chartd 0 ) "

Ignare Chart Anschlie3end alles abwahlen.

| Select » Sie sehen nun |hr Modell

eingefarbt.
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Autoll: cylinderl Rechtsklicken Sie um
das Kontextmeni ein
weiteres Mal zu
offnen. Dieses Mal
wahlen Sie
«Continue» >
«Unfolding» (weiter >
entfalten).

Dies erzeugt die
Umrisse dieses

Lcotiue [ nfocing o &
L1 O .
| Projection Abwicklung.
segment by ]
AuvChartl

Auy Chzrt2
AuyChzrt3

Ay Chartd
AuyCharts
Auy Charts

(A TR S S

o

H D EEC

Ein Fenster mit der Abwicklung 6ffnet sich. In
diesem Fenster rechtsklicken Sie, um ein weiteres
Kontextmenu zu 6ffnen. Hier klicken Sie auf
«Create Texture» (Textur erzeugen).

Chart operations

Move
acale b
Fotate b

Flip 3
Tighten

Delete

FeMap Uy b

Create Texture

www . davidbrinnen.com —8— www . horo.ch



WINGS - Minitutorial — 07 — WINGS Kurzanleitung

— Edge Options

® Draw Al Edges
& Oraw Border Edges
< Do’ t Oraw Edges

— Overdraw options
[ Use Face/Vertex Color on Border Edges

Edge width |2,0

— Display Color and texture?
W Show Colors {or testure)

[ Texture Background (if available)

— Texture Size

O 1281128 (48kh)
O 2EE%Z56 (15827kh)
® 512512 (T65Khb)
O 1024%1024 (3Mb)
O 2048x2048 (12Mk)
O 40984096 (43M0)

Stellen Sie sicher, dass Sie die selben
Optionen ausgewahlt haben, wie links
gezeigt. Die Grol3e ist tatséchlich unwichtig.
Dies wird die GroR3e des Bildes mit der

Abwicklung sein.

512 x 512 is eine gute Wahl. Wenn Sie sehr
hochaufgeloste Bilder fur die Abwicklung
benutzen werden, mogen Sie diesen Wert
vergrofRern.

AutolyY: culinderl

Outliner Zum Outliner

A Fenster
gehen, auf
«diffuse»
rechtsklicken
und «Make

| dif fusze

External ...»
auswahlen.

Malke External,..

Im sich
offnenden
Speichern
Dialog der
Datei einen
Namen
geben.
Andern Sie
diesen
Namen

Ewport,..

Duplicate
Delete
Fenarme

S
ot

nicht mehr.

www . davidbrinnen.com

—9— www .horo.ch



WINGS - Minitutorial — 07 — WINGS Kurzanleitung

Dies ist nun die
externalisierte
Abwicklung, welche Sie
mit Threm Grafik
Programm 6ffnen und
Ilhre Bilder anwenden,
wie es Lito Nicolai
weiter oben erleutert
hat.

—(

www . davidbrinnen.com — 10— www . horo.ch



WINGS - Minitutorial — 07 — WINGS Kurzanleitung

Fir dieses Beispiel
kolorierte ich einfach
die verschiedenen
Flachen, welche ich mit
dem Zauberstab
auswahlte. Das ist
bestimmt nicht die
aufwandigste Methode,
um Abwicklungen zu
benutzen, aber sie
erfullt ihren Zweck hier.

Wenn Sie mit der
Einfarbung der
Abwicklung fertig sind,
speichern Sie das Bild
unter gleichem Namen
und mit gleichem
Dateityp, wie Sie es
ursprunglich getffnet
hatten. Der Dateiname

darf nicht verandert
werden. Erinnern Sie
sich?

Outliner

Make Internal

Export,..

Duplicate
Delete
Ferarne

www . davidbrinnen.com

Gehen Sie zurtick zu Wings3D und dem Outliner Fenster.
Rechtsklicken Sie wieder auf «diffuse» aber diesmal
wéhlen Sie «Refresh» (erneuern) um die eingefarbte
Abwicklung um Ihr Modell zu wickeln.

Eigentlich kbnnte dieser Schritt tbersprungen werden. Sie
konnen jederzeit die Abwicklung in Bryce um Ihr Modell
wickeln. Wir werden das weiter unten noch diskutieren.
Zum jetzigen Zeitpunkt folgen wir den Beschreibungen von
Lito Nicolai.
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Outliner

B cif fuse

Hew Ctri+H
Oper, .. Ctri+0
Merge... Ctri+L
Save Ctri+5
Save A=,.. Ctrl+Shift+3

Save Selected,..
Save Incrementaly

Revert

Irport
Export

Eport Selected

0 edges, 48 vertices,

— l
: Fl

Impart Image...

Render

Inztall Plug-In

www . davidbrinnen.com

Mendo (ndo .,

20 Studio (,3ds

Cartoon edges {.eps)...
Wavefront {.obj)...
Fenderware i) ...
VRHL 2.0 Cowrl) ...,

OoOooOono

Hier sehen Sie die
erneuerte
Abwicklung. Nach
der Auffrischung eine
erfrischende Ansicht.
Beachten Sie auch,
dass das kleine
weil3e Quadrat unter
«diffuse» nun ein
Vorschaubild der
Abwicklung zeigt..

Das Model muss
gewahlt sein. File
(Datei) Menu
offnen, «Export
Selected» > «3D
Studio (.3ds)...
wéhlen und Modell
zusammen mit Ab-
wicklung speichern.
Auch «Wavefront
(.obj)... ist maglich,
Bryce importiert
beide. Die 3ds/obj
und mtl Dateien
gehoéren zusammen
mit dem Bild der
Abwicklung ins
gleiche Verzeichnis!

www . horo.ch
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DIFFUSE
AMBIENT ¢
SPECULAR ¢

AMBIENCE "4
SPECULARITY g

WINGS Kurzanleitung

Nachdem das Modell als
Objekt in Bryce importiert
wurde zeigt sich im
Material-Editor in Kanal A
die Abwicklung, im
Parametrischen Mapping-
Modus.

Dieses Beispiel ist von
3ds: Der Wert fur Diffuses
Licht (Diffusion) kann
manuell nicht auf 255
gestellt werden.

Wie oben
erwahnt kann
das Bild der
Abwick-

lung separat
in Bryce
importiert
werden.
Daher kbnnte
der "Auffrisch"
Schritt in
Wings3D
Ubersprungen
werden.

Hier ist das aufRerordentliche Meisterstiick gerendert in Bryce,
sehen Sie es an und erleben echte Erfurcht ;-)

Mit Abwicklungen zu arbeiten hat vieles fur sich. Jede Seite
auch eines aufwandigen Modells kann einzeln mit einer Textur
versehen, komplizierte Zeichnungen aufgetragen werden.

Verglichen mit prozedurale Materialien vermissen wir naturlich
das Relief. Solches kann jedoch durch die anderen Kanéle (B,
C, D) in Bryce hinzu gefugt werden.

Hans-Rudolf Wernli

www . davidbrinnen.com
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Making Mushrooms in Wings 3d:

This tutoria consists of two parts; Simple Mushrooms and Complicated Mushrooms. The
first shows how to make avery simple mushroom. The second documents the making of
amore complex and realistic mushroom.

Introduction:

Thistutorial assumes you have a decent working knowledge of Wings 3d and it’s
commands. It is also recommended that you have a drawing program (Alias Sketch Book
Pro trial works well) for the Complicated Mushrooms.

Part I: A Simple Mushroom
Start by (as per usual) opening up the geometry graph. This helps keep track of objectsin
the scene. Y ou won’t be needing it much for thistutorial, but it is aways helpful to see
what’ s selected. Next, change camera view to orthogonal. Start off by creating a cube.
Scale it down until it reaches the diameter of what you want the stem of your mushroom
to be. Select the top face and go into the Z-axis view. Extrude the top face of the cubein
gments, moving and rotating where you want the curves and bends to be.

=

Notice | have moved the faces alittle dlong the x axistoo. Thisis perfectly acceptable,
and it makes the mushroom look more redistic. Where you want the top of your
mushroom to be, extrude a short segment straight up. Select the four side faces of this
segment and “extrude region”. Thisisyour cap. Move the selected faces down some,
select the bottom edges of those faces and scale.



move the top edges of those faces down

until they reach the level of the bottom ones.

you are finished! Hit shift>tab to seea

smoothed preview of your mushroom!



Complicated mushrooms:

These are, as the name implies, more difficult than the simpler mushrooms. They aso
happen to look quite alot better. The first thing you need for these mushrooms are
references. | spent several hours looking through the Roger Tory Peterson book of
mushrooms (I also spent afew hours playing through one of the Myst games and taking
screenshots). Eventually | came upon adesign | liked. The second thing you need is a
sketch, preferably side-on. | made one with the Alias sketch book Pro trial (I did it with a
mouse; it was incredibly difficult. | recommend atablet).

Import your sketch into Wings as an image plane. Create a cube and start extruding,
scaling and rotating to match the contours.



Thisiswhat | got after afew hours of work (this has
been smoothed once). Asyou can see, thisis pretty high detail. Once you done, smooth it
once and zoom in on the part you want your gillsto be.

Select al of the edges that you want to have gills (like this)



I

L — ]
Subdivide the edges by nine (or hit the“9” key). You will get lots of vertices. Connect
them (“C” key). It should look something like this.

Microso...  ~ | s Bryce 5.5 ‘R Masterofea...  K§ 2 werl -| @ RealPlayer:... =5 £ ‘O & E 153 AM

Select al of the vertical edges (using the“G” key) and extrude. If you like, you can
delete all of the vertices sticking out to make the gills more realistic. Do this by using the
“1” key (“select similar”).

By Lito Nicolai



